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Introduction  
Information that is stored on our disks can be much more valuable than the computer 
being used together with its software. –Then again, to what extent is something regarded 
as valuable? How much money would you ask for your favorite music collection, which 
you have been collecting your entire life? Or your disk may contain important financial 
data or results of scientific research. There are many things that are unique and therefore 
one has to be certain about security. 
 
Our program provides the user with the most reliable data protection for the hard disk – 
the ability to create archive duplications (i.e. backup images).By storing such an archive 
onto external media the user is able to restore the data at any time it is required. The 
program assists planning a schedule in case the user’s disk needs a backup on a regular 
basis. The operation will be performed automatically at the specified time. The key 
features of the program are listed in the special chapter. 
 
Setting up any operation is accomplished by using practical wizards. Each step of the 
wizard includes in-depth information in order to allow the user to make the right choice. 
Graphical representations of the data help the user to gain a better understanding. 
 
In this manual you will find the answers to many of the technical questions which might 
arise while using the program.  
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Key Features  
Let us list some of the key features:  

o  Friendly user interface. Easily understood icons accompany all 
functions of the program.  

o  Easy-to-use wizards that provide the possibility to build up a reliable 
data protection system, and that even beginners may understand.  

o  Backup an entire disk including service data of the file system.  

o  Schedule the backup operation. The user can set a convenient time for 
the program to perform the operation automatically.  

o  Create and manage the backup capsule. This is a special secured place 
on the disk where backup archives are stored.  

o  Restore an entire disk or separate files from the disk archive (image).  

o  Browsing disk archives with our special tool called Image Explorer.  

o  Build external recovery media that help the user to restore the system 
even when the current operating system cannot boot anymore.  
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Installation  
This chapter provides information which is needed to perform the correct installation of 
the program, and in addition, checks if the current installation is working correctly.  

Package Contents  
The installation package includes the following components:  

o  Launcher (with an embedded HTML browser)  

o  Backup Wizard  



o  Scheduler with Task Editor  

o  Restore Wizards  

o  Image Explorer  

o  Manage Backup Capsule Wizard  

o  Recovery Media Builder  
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Minimum System Requirements  
To use the program on a computer satisfactorily, ensure that it meets the following 
minimum system requirements:  

o  Operating systems: Windows 95/98/ME/NT/2000/XP (Note! The 
current version of the program cannot run and be installed on server 
releases of Windows)  

o  Internet Explorer 5.0 or higher  

o  Intel Pentium CPU or its equivalent, with 300 MHz processor clock 
speed  

o  128 MB of RAM  

o  Hard disk drive with 40 MB of available space  

o  SVGA video adapter and monitor  

o  Mouse  
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Basic Concepts  
This chapter explains terms and ideas that show how the program works. To understand 
these helps to obtain a general notion of the operation performance and makes it easier 
for the user to operate the program.  



Backup Operations  
Since the advent of the computer age the best way to protect valuable information was to 
store it in form of archives on external media. In case of hard disk malfunction, its 
contents could be restored from the archive. Then backup soon became a common term 
to mean making duplications of data for protection purposes. 
 
Nowadays backup has become an essential routine operation for any serious information 
work. A modern backup archive uses the so-called image, a snapshot of the whole disk 
system (or its separate partitions). It not only includes the contents of all user-made files, 
but additionally contains the exact structure of directories, information about file 
allocation, file attributes and other related data. A backup image can be copied or moved 
like any ordinary file. 
 
The user can store backup images on external media (CD/DVDs). This guarantees a high 
level of data protection as long as the backup media is kept secure. It is possible to store 
backup images on a local network drive as well. Special server-side software enables to 
secure and store backup images for the entire network. For this purpose computers named 
backup servers are used. Such a backup server provides nearly the same level of 
protection as external media. 
 
However, should the user not have a local network and/or it is inconvenient to record data 
onto external media, then the backup images can be stored in a specially secured place on 
the hard disk. This place is referred to as the backup capsule, which has an independent 
system layout (e.g. a separate partition) that will stay operable should the active file 
system be damaged. To avoid an accidental removing or unauthorized access of the 
backup data, this partition is hidden and thus cannot be mounted in the operating system. 
A single hard disk may contain only one backup capsule. However, the user can attach 
another hard disk with an existing backup capsule to the computer and restore from that 
as well without any problems. 
 
It is only possible to browse the contents of the backup capsule by using special software. 
The system of wizards that is implemented into the program is designed to work with the 
backup capsule. Thus, by storing disk images in the backup capsule the user obtains a 
reliable level of data protection. 
 
The above-mentioned methods of storing backup images are implemented in the 
program. And all the necessary actions are performed by using the system of convenient 
wizards. This means that the user simply has to follow easy step-by-step instructions to 
make the appropriate settings.  
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Scheduling  



The automation of the program’s operations is particularly effective when the user has to 
repeat a sequence of actions on a regular basis. For example, when a specific project is 
being developed on a computer on a day-to-day basis and a backup copy is made every 
evening so as not to lose the valuable data, it should be possible to simplify certain 
routine operations. Certain operations really need to be automated to facilitate the task of 
multiple executions and setting a precise time for its completion. 
 
Another aspect of any automation process is that it runs automatically without the user 
having to be present. The program is able to execute operations without the user being 
involved. In addition, it allows an optimization of your computer’s work-load. This is 
especially important when operations require a considerable amount of computer 
resources – processor time, memory and more. A number of operations, which can 
decrease the performance, can be run during the night or whenever the computer has the 
least work-load to perform. 
 
The program has a special tool for scheduling backup operations. The user can set out a 
timetable for various backup operations. For example, some backup operations may be 
performed daily, others - weekly and so on. The scheduled backup starts at a specified 
time without interrupting the user's current activity (due to using Hot Backup).  
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Interface Overview  
This chapter introduces the graphical interface of the program to the user. The design of 
the interface precludes any mistake being made on the part of the user. All operations are 
performed through the system of wizards. Buttons and menus are accompanied by easy 
understandable icons. Nevertheless, any problems that might occur while managing the 
program can be tackled by reading this very chapter.  

General Layout  
When the user starts the program, the first component that is displayed is called the 
Launcher. It enables the user to run wizards and utilities, to specify program settings, to 
visualize the operating environment and the hard disk configuration. 
 
The Launcher's window can be conditionally subdivided into several sections that differ 
in their purpose and functionality: 



1. Main Menu  
2. Tool Bar  
3. Common Tasks Bar  
4. Explorer Bar  
5. Disk Map  
6. Status Bar  
 
Some of the panels have similar functionality with a synchronized layout. The program 
enables the user to conceal some of the panels to simplify the interface management. 
 
All panels are separated by vertical and horizontal expandable sliders, allowing the user 
to customize the screen layout.  
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Main Menu  



The Main Menu provides access to the entire functionality of the program. The available 
functions are as listed below: 

MENU ITEM  FUNCTIONALITY  
Tools     
Reload Disk 
Info  Refresh the current information about disks  

Settings  Edit the general settings of the program  
Exit  Exit the program  
Wizards     
Back Up to 
Exact Image…  Create a new backup archive  

Schedule 
Backup…  Schedule a backup operation  

Restore from 
Exact Image…  Restore a disk from the backup image  

Manage Backup 
Capsule...  Create or manage a backup capsule  

Navigate     
Back  Return to the previously browsed page  
Forward  Open the next browsed page  
Stop Browser  Stop loading the current page  
Reload current 
page  Refresh the contents of the current page  

View     

Toolbar  
Manage the Tool Bar representation: show / hide 
standard and navigation buttons, text labels and large 
icons.  

Status Bar  Display the Status bar  
Common Tasks 
Bar  Display the Common tasks bar  

Disk Map 
Location  

Select whether the Disk map will be located on the 
top of the main window or at the bottom  

Help     
Help  Open the Help system  
About  Open the dialog with information about the program  
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Tool Bar  
The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY  

 Create a new backup archive  

 Schedule a backup operation  

 
Restore a disk from the backup 
image  

 Open the Help system  

 
Return to the previously 
browsed page  

 Open the next browsed page  

 Stop loading the current page  

 
Refresh the contents of the 
current page  
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Common Tasks Bar  
The Common Tasks Bar is located on the left side of the main window. It is intended for 
easy access to the program's wizards that provide all the functionality needed to manage 
backup archives. 
 
The bar contains two tabs named Select a Wizard and News and Documentation. Each of 
these contains a separate button bar which can be folded by clicking it. 

Select a Wizard     

 

Starting the Backup Wizard. The Backup Wizard 
assists the user with the backup of the hard 
disk’s data. 

 

Starting the Backup Wizard with the preset 
scheduling option. 

 
Starting the Restore Wizard. The Restore Wizard 
helps to restore data from a previously made 



backup image. 

 

Starting the Manage Backup Capsule Wizard. 
The Manage Backup Capsule Wizard helps to 
create, resize or delete the backup capsule. 

 

Starting the Recovery Media Wizard. The 
Recovery Media Wizard helps to create media 
which can be used for recovery purposes. 

 
Starting the Exact Image Explorer. The Image 
Explorer allows browsing backup images.  

News and 
Documentation     

 

Opening the page which contains information 
about the program. This page will be displayed 
in the Explorer bar. 

 Launching the Help system.  
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Disk Map  
The Disk Map is displayed in the Explorer bar when the Disk View tab is selected. It is 
located either at the top or at the bottom of the window, depending on the state of the 
Disk Map Location option (Main menu: View > Disk Map Location). The user can 
change the current location of the map with this option. 
 
As the name infers, the Disk Map displays the layout of physical and logical disks. 
Physical disks are represented with rectangle bars that contain small-sized bars. These 
small-sized bars represent logical disks. Their color depends on the file system of the 
appropriate partition. 
 

 
 
Large-sized bars display the following information about physical disks: 
o Serial number, 



o Manufacturer, 
o Model. 
 
Small-sized bars display the following information about logical disks: 
o Drive letter, 
o Total size, 
o File system. 
 
Furthermore, it is possible to estimate the used disk space by looking at the size of the 
bar’s shaded area. 
 
Disk Map is synchronized with the Explorer bar. When the user selects a disk on the 
Disk Map the Explorer bar displays detailed information of the selected disk. 
 
Note! The user can click a large-sized bar to display information about the appropriate 
physical disk in the Explorer bar. A click on a small-sized bar will lead to displaying 
information about the appropriate logical disk..  
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Explorer Bar  
The Explorer Bar is located in the center of the main window which emphasizes its 
importance. The bar displays reference information including: 

o User Manual, 
o Information about the program consisting of the product's name, the 
version of the program and a list of helpful links),  
o Detailed information about disks selected on the Disk Map, 
o List of scheduled backup archives. 

According to these categories the Explorer bar has three tabs: 

o Disk View, which allows the user to view detailed information about 
any of the disks. 
o Scheduled Backups, which gives the user the possibility of browsing 
and editing scheduled backups. 
o Help System, which contains the User Manual and information about 
the program. 

The user is able to access the desired information by clicking on the appropriate tab. 
 
The Explorer Bar is a fully-functional embedded HTML browser, which enables the user 
to address, for example, our company's website to look through important technical notes 
or download the latest updates without having to close the program. The Help System of 



the program is HTML-oriented. The user can read the user manual and follow external 
links from to get additional information. 
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Status Bar  
This is the bottom part of the main window. The status bar displays menu hints, for each 
item the cursor points to. 
 
The user can hide (or show) the bar with the appropriate main menu item: View > Status 
bar.  
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Settings Overview  
The Settings dialog is available from the Main menu: Tools > Settings. All the settings 
are grouped into several sections of which the functions are described in the following 
paragraphs. The list of sections is placed on the left side of the dialog. By selecting a 
section from the list, the user opens a set of options.  

General Copy and Backup Options  



 
 
This section contains a set of options that will be taken into account during copy and 
backup operations. The user can switch between the following modes: 

o Copying all sectors of the disk. 
o Skipping OS auxiliary files during backup operation. 
o Processing data without restarting the system. 

In order to activate an option the user should mark the appropriate checkbox.  
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Backup Image Options  



 
 
This section contains a set of options that will be taken into account during the creating 
backup images and restoring disks from them. The user can activate the following modes: 

o Controlling archive integrity, 
o Automatic setting file names in case of complex archives, 
o Splitting images to several files, 
o Compressing a backup image. The user can also define the compression 
level. 
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CD/DVD Recording Options  



 
 
This section contains a set of options that will be taken into account during the CD/DVD 
burning operation. The user can define: 

o Recording speed 
o Folder where the ISO image is to be placed. 
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Hot Backup Options  



 
 
This section contains a set of options that will be taken into account in case the Hot 
Backup mode is enabled. The Hot Backup mode is a part of the backup operation that 
allows the program to process a disk without restarting the computer. The program forces 
the system to restart to obtain exclusive access to the processing data. The Hot Backup 
mode may be used to process locked partitions or any backup operation. The user defines 
the method in this section. 
 
The user can also set a Temporary drive. This option defines a partition (by default – C:) 
for the Hot Backup temporary file. The temporary file will be deleted when the hot 
backup is performed which may require a large amount of disk space Should there not be 
enough space on drive C:, then another drive needs to be selected.  
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How to Protect Data  
This chapter lists various scenarios of data protection which may be accomplished by the 
program. This has already been reviewed in the Basic concepts chapter. Here the user 
will find more useful recommendations and descriptions of operations.  

Getting Information about Disks and their Images  



To begin with, let us examine the current situation of the available disk space. We look at 
the properties of our disks or peculiarities of existing backup images. The program 
provides some helpful tools for this purpose.  

Viewing Disk Properties  

The user is able to view in-depth information on the properties of hard disks. The main 
tool to extract this information is the Disk Map. It represents the actual state of the 
computer’s hard disks. The Disk Map chapter is a detailed description on this topic. 
 
Generally the hard disks are represented on the map by rectangular bars, which also 
contain small-sized bars. The small-sized bars represent logical disks (partitions). When 
the user selects a large-sized bar, the Explorer bar displays information about the disk in 
a bright, graphical form.  
 

 
 
The model and serial number of the disk serve as the title of the browsed page. The disk 
layout is shown in form of a circular graph, where the color of a sector corresponds to a 
file system of an appropriate partition. On the right the user may see a table, which 
contains the following information: 

o Type of hard disk (basic or dynamic), 
o Total size (in GB), 
o Information on geometry of the disk (amount of sectors per track, heads 
and cylinders). 

Below there is a list of wizards available for the user. If the user clicks a corresponding 
record the appropriate wizard will be started. All default values for the operation 



parameters will correspond to the disk’s settings. The list of wizards contains a detailed 
description of tasks that can be performed by the wizard. This nullifies the possibility of 
selecting the wrong wizard. 
 

 
 
When the user selects a small-sized bar (i.e. corresponding to a logical disk), the Explorer 
bar will display information on it as well. The page title will contain a drive letter, which 
is assigned to the disk. The disk layout graph will be colored in accordance with the 
volume ratio of the used space to the free space (the light colored sector). The table on 
the right will contain the following information: 

o Volume label (if available), 
o Type of the logical disk, 
o File system (represented by the color of the graph and the selected bar), 
o Total size, used space and free space (in GB or MB). 

Below there is a list of wizards, which may be called for this disk. All default values of 
parameters will correspond to the disk settings.  
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Viewing Image Properties  

Before restoring a disk from an image it is necessary to be sure that it is the image you 
need. To obtain general information about an image you can use the Restore wizard. It is 
very convenient to use because it provides the possibility to cancel the operation at any 
step. 



 
There are several ways to launch the Restore Wizard: 

o In the Main menu: select Wizards > Restore from Exact Image 
o In Common Tasks bar: click the Restore from Exact Image item of the 
Wizards menu 
o Select a logical disk and then click the Restore the disk from an image 
link on the Explorer bar page. 

At first, the wizard displays the Welcome page – simply click the Next button at the foot 
of the dialog window. 
 

 
 
The next page refers to Browse for Archive. Here you can select an image on your disk in 
the browser-like window. The section below (i.e. Archive File Details) displays a short 
description of the selected image, including: 

o information on a type of the archive contents (whether it contains the 
entire disk or just a partition), 
o whether the archive is compressed or not, 
o whether the archive is password protected or not, 
o the date, when the archive was created. 



 
 
The next page (i.e. What to restore) displays detailed information about the contents of 
the archive. It includes a full description of properties about the archived disks or 
partitions. 
 
If you want to restore the contents of the image click the Next button. In order to cancel, 
click the Cancel button.  
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Viewing Image Contents  

The user may browse the contents of the archives with a special utility called Exact 
Image Explorer. To start the utility, one should click several times on the Exact Image 
Explorer button in the Common Task bar.  
 



 
 
The utility displays the list of archives in the left panel. The right panel of the program 
displays contents of an archive selected in the left panel. In case the user selects an 
archive, the browser panel displays the files contained in that archive. If an archive 
includes several backup archives, the utility will display them as top-level expandable 
nodes. 
 
In order to browse an archive, it should be added to the list of the left panel. In order to 
do so, the user can choose one of the following options: 

o Select an archive in the right panel, call the context menu and then select 
the Browse archive item, 
o Select in the Main menu of the utility: File > Load archive. 

The selected archive will be added to the list and will be available for browsing. 
 
Image Explorer also provides the possibility to extract separate files and folders from 
archives without restoring the whole archive. 
 
Image Explorer can work with any kinds of archives created by the program. For 
example, it can browse the Backup Capsule which is hidden from any standard Windows 
program.  
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Backup a Disk  
In the Basic concepts chapter we mentioned that the most prevalent way to protect 
valuable data is to create backup copies (backup images in terms of the program) of it. 



This operation can be accomplished with the Backup Wizard. The wizard is so well 
designed that the user simply needs to follow its easy instructions to make an exact image 
of the disk.  

Starting  

There are several ways to start the Backup Wizard: 

o In the Main menu: select Wizards > Back Up to Exact Image 
o On the Common Tasks bar: click the Backup to Exact Image item of the 
Wizards menu. 
o In the Toolbar: click the Back Up button. 
o Select a disk on the Disk map and click the Create the image of the 
logical disk item on the page that appears in the Explorer bar (when the 
user selects an entire hard disk on the Disk map the item is named Create 
the image of the entire disk). 

After following one of the above mentioned actions, the Welcome page of the wizard is 
displayed. 
 

 

Settings  



The Backup Wizard allows the user to configure the settings and then start the operation 
in accordance with the entered parameters. Here the user sets the parameters of the 
backup operation defining: 

o The disk to archive. The user can backup either an entire disk or 
separate partitions of the disk (primary, extended or logical). In case of 
backing up an entire disk, the user has the possibility to include into the 
image such disk elements as the Master Boot Record (MBR) and the first 
track of the hard disk. This can be very helpful for serious disk recovery 
procedures. 
o The destination where the future backup image will be stored. The 
Backup Wizard allows saving backup archives to local or network drives, 
to physical partitions (without drive letters assigned), or burning them to 
CD/DVDs. It is also possible to place the archives in the Backup Capsule. 
The user needs to select a destination, taking the estimated archive size 
and available space on the backup destination into account. 
o The method of the operation performance. By default the program 
suggests the user to start the operation immediately. 

In addition, there is the possibility to make further detailed settings (although the default 
values will do in most cases). To activate the advance mode, the user needs to mark the 
appropriate option on the second page of the wizard (i.e. the What to back up page). The 
checkbox is to be found at the foot of the page. When it is marked, the next page allows 
the user to define: 

o Whether the selected disk (or the selected partition) will be copied in the 
sector-to-sector mode (including unused sectors as well). 
o Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be 
included in the backup image. 
o Whether the operation will be performed without rebooting the system. 
The program needs to reboot the system in order to have exclusive access 
to processing data. In a Windows environment this is difficult to achieve 
because even when all the other applications are closed, the system service 
programs are still running. However, there is a way to avoid rebooting. 
The mode of processing the backup operation without rebooting is named 
Hot Backup. The user is also able to define specific parameters for the 
Hot Backup mode. 
o Whether the archive integrity will be controlled. 
o Compression level for the backup image (including the No compression 
variant) 
o Whether the archive will be protected by password. 
o Whether the archive will be split (if this is the case the user can set the 
maximum size for the archive files). 
o Recording speed when the user wants to burn the backup image onto 
CD/DVDs. 



o ISO image folder where the archive that is to be recorded on a disc, is 
placed. 

Results  

Depending on the user’s choice the Backup wizard: 

o starts the backup operation  
o schedules it  

After the backup operation is completed the user receives an image of the selected disk 
(or the selected partition). This image is placed into the specified destination (a local or 
network disk, or a CD/DVD disc), its features defined by the wizard.  
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Scheduling Backup Operations  
The program allows the user to automate the backup operations. The utility for this 
purpose is referred to as the embedded Scheduler, which is used to specify the time for 
the execution of the backup operation. There are two categories for time settings (these 
correspond to appropriate items in the Schedule type menu): 

o Initiating the backup operation by an event: 
- One time only (i.e. the Once item) 
- When system starts (i.e. the At System Startup item) 
- When the user logs on (i.e. the At Logon item). 
o Initiating the backup operation periodically (i.e. Daily, Weekly, 
Monthly). 

The user needs to select one of the variants. Depending on the choice, the scheduler will 
display a form that allows the user to set the schedule. Let us review available variants of 
settings and examine situations for which these parameters would be most suitable. 
 
There are situations when the user wants to make a major update of a program project or 
make serious modifications in the system settings (it should be remembered that the 
backup image contains full information about a disk). For every mentioned case it is 
possible to schedule the backup operation only once by selecting the appropriate Once 
item in the Scheduler’s menu. The bottom section of the dialog window displays fields 
that help you define the date and time when the operation should begin. 
 



 
 
When making serious system changes, the start of the backup operation can be connected 
with the user’s logon or with the system start up. It optimally corresponds to the At 
Logon or the At System Startup items of the menu. The lower section of the dialog 
window will display fields that help you specify conditions for starting the operation: 

o The operation begins automatically with every logon 
o The operation is started on the next logon after which the task will be 
deleted from the scheduler. In this case the backup operation will be 
performed only once. 
o The operation is started on the next logon and is then repeated at every 
logon. The length of the interval between operations can be configured 
here. 



 
 
As described earlier on where the user needs to backup data every evening, in this case 
the Daily menu item in the Scheduler’s window needs to be selected. After selecting the 
option, the lower section of the window will allow the user to define the following 
parameters of the operation initiation: 

o The time when the backup operation starts 
o A period during which the backup operation will be performed (in days) 
o The date when the backup operation will be started first and the date 
after which the task will be deleted from the scheduler's waiting list 



 
 
Moreover, the user can make an additional backup copy onto external media (e.g. burning 
a disk image onto CD/DVD) on a weekly basis. This provides your data with further 
protection. In order to schedule the period of the operation performance, it is necessary to 
select the Weekly item of the Schedule type menu. The lower section of the window will 
allow the user to define the following parameters of the start of the operation: 

o The time when the backup operation starts 
o A period during which the backup operation will be performed (in 
weeks) 
o Days of the week, when the operation will be started 
o The date when the backup operation will be started for the first time and 
the date when the operation will cease to run. 



 
 
Finally, backing up data onto external media can be accomplished on a monthly basis. To 
set the times, the user needs to select the Monthly item of the Schedule type menu and 
then define the following additional parameters: 

o The time when the backup starts 
o A day of a month when the backup will starts 
o The date when the backup operation will be started for the first time and 
the date when the operation will cease to run. 



 
 
After completing the schedule please check the settings on the last page of the Backup 
Wizard (the Backup schedule section). 
 
All scheduled tasks are placed in a separate list, which can be retrieved by clicking the 
Scheduled Backups tab in the Exlorer bar. When the Scheduled Backups list contains 
too many backups, the user can arrange the scheduled tasks in the correct order with the 
Task Editor. The Editor allows the user to change the date and time, and delete scheduled 
jobs. 
 
In order to call the Task Editor, the user can either: 
o Double-click on the appropriate task in the Scheduled Backups list 
o Select the Properties of the context menu, which can be called by a right-click on the 
appropriate task. 
 



 
 
The dialog window has two tabs - General and Schedule. The General tab contains: 
o The full path to the program-interpreter of the macro-commands which describes the 
scheduled task 
o The line of parameters for starting the interpreter (i.e. the task described in macro-
language) 
o Comments referring to the task 
o The option of enabling/disabling the task. 
 
The Schedule tab tab contains the timetable of the task, which the user can modify. In 
order to apply the changes, the user needs to click the Apply button at the foot of the 
dialog. 
 
The user can also delete the scheduled task by calling the context menu of the task and 
selecting the Delete item.  
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Storing Backup Images onto External Media  
To store backup images on CD/DVD with the Backup Wizard, simply do the following: 



1. Click the Back Up button in the Tool bar (any of the ways described 
earlier can also be used here to call the Backup Wizard). 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. On the What to back up page, mark the appropriate option opposite a 
hard disk’s name or a partition’s name depending on the chosen task. 
Click the Next button. 
 
4. On the Backup Destination page, select the Burn the data on CD / 
DVD option. Click the Next button. 
 
5. Select a recordable device on the list and edit the archive name, if 
necessary. Click the Next button. 
 
6. Add comments to the backup describing its contents. 
 
7. Select how to perform the operation: 

o immediately (the Back up now option)  
o schedule the operation  

Click the Next button. 
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Storing Backup Images on a Network Drive  
To save a backup archive on a network drive with the Backup Wizard, simply do the 
following: 

1. Click the Back Up button in the Toolbar (any of the ways described 
earlier can also be used here to call the Backup Wizard). 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. On the What to back up page, mark the appropriate option opposite a 
hard disk’s name or a partition’s name depending on the chosen task. 
Click the Next button. 
 
4. On the Backup Destination page, select the Save data to local/network 
drives option. Click the Next button. 
 
5. Select a network disk (it must be mounted and be available in the 
system by a drive letter). Please take into account values of the parameters 



Estimated archive size and Space available on backup destination - if the 
archive size exceeds the available space, another network drive needs to 
be selected. 
 
6. Edit the archive name if necessary and click the Next button. 
 
7. Add comments to your backup describing its contents. 
 
8. Select how to perform the operation: 

o immediately (the Back up now option)  
o schedule the operation  

Click the Next button. 
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Using the Backup Capsule  
When the user starts the program, it checks whether the Backup Capsule exists in the 
system or not. If it has not been found, the user is offered to create a Capsule 
automatically. All operations related to the Backup Capsule, including its creating and 
managing, are performed with the Manage Backup Capsule Wizard.  

Starting  

There are several ways to start the Manage Backup Capsule Wizard: 

o In the Main menu: select Wizards > Manage Backup Capsule 
o On the Common Tasks bar: click the Manage Backup Capsule item of 
the Wizards menu. 
o Select a bar corresponding to the hard disk on the Disk map and click 
the Create a Backup Capsule item on the page that appeared in the 
Explorer bar. 



After any of the mentioned actions the Welcome page of the wizard will be displayed. 
 

 

Settings  

The Manage Backup Capsule Wizard allows the user to configure the settings and then 
start the operation in accordance with the entered parameters. In our case we set the 
following parameters of the backup capsule: 

o The place where the backup capsule will be created. The user should 
select a hard disk (if the computer has several hard disks) and then select 
position for the future backup capsule on the disk. 
o The size of the backup capsule. It will be created at the expense of free 
space of the selected disk. 

Results  

Depending on the user’s choice the Manage Backup Capsule Wizard: 

o Starts the operation 
o Allows the user to return and correct the parameters mentioned above. 



After the wizard has completed, the user will have created a secured place, i.e. the backup 
capsule, in which new backup archives can be stored. 
 
The Backup Capsule can be created as a primary partition or as a logical drive within an 
extended partition. The Backup Capsule can be inserted into any place on the hard disk: 
at the end (preferable), at the beginning or somewhere in the middle between other 
partitions. There is no restriction on the size of the Backup Capsule, merely depending on 
the available space of the hard disk and the capacity needed for the backup. 
 
If the Manage Backup Capsule Wizard cannot find enough free space in one block, the 
wizard will redistribute free space, joining all free space blocks together into one united 
block and moving partitions when necessary. If the total amount of free space is still not 
enough, it is possible to split a fragment of space from one of the existing partitions, thus 
resizing it. 
 
If the partition is locked and cannot be resized, the Manage Backup Capsule Wizard 
makes the system reboot to create the Backup Capsule and automatically boots the 
system again. (The rebooting mechanism is different for different versions of Windows.)  

Managing the Backup Capsule  

All operations of the Backup Capsule management are performed with the Manage 
Backup Capsule Wizard mentioned above. The user can: 

o Change the backup capsule size, if necessary 
o Store multiple backup images 
o View and control stored images 
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Backup Capsule on a Disk with only one Partition  
Suppose that the user has only one hard disk with only one partition (the only partition is 
always system). Suppose that there is enough free space on the hard disk to create the 
backup capsule as well. It can be created with the Manage Backup Capsule Wizard: 

1. On the Common Tasks bar, click the Manage Backup Capsule button. 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. Select a place on the disk where the backup capsule will be created 
(see the illustration below). Click the Next button. 
 
4. Set the size for the backup capsule. Click the Next button 
 



5. Start the operation (by clicking the Next button) or return to correct the 
settings. 

 
 
After this, the user can place the backup archives into the created backup capsule. For 
example, one could take a full snapshot (with compression) of the system partition at 
monthly intervals and perform incremental backup on a daily basis.  
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Restoring a Disk from the Image  
The restoring process is the reverse of the backup operation, and is performed less 
frequently. The program includes convenient and reliable restore wizards: Restore 
Wizard and Simple Restore Wizard. The Restore Wizard is intended to work under 
Windows. The wizard provides easy to understand instructions which allow the user to 
configure and perform all the necessary settings.  

Starting  

There are several ways to start the Restore Wizard: 

o In the Main menu: select Wizards > Restore from Exact Image 
o On the Common Tasks bar: click the Restore from Exact Image item of 
the Wizards menu. 
o Select a bar corresponded to a hard disk (or a partition) on the Disk map 
and click the Restore the entire disk from an image item (or the Restore an 



image of the logical disk from an image item in the partition case) on the 
page that appeared in the Explorer bar. 

After any of the mentioned actions the Welcome page of the wizard will be displayed. 
 

 

Settings  

The Restore Wizard allows the user to configure the settings and start the operation in 
accordance with the entered parameters. In our case we set the following parameters of 
the restore operation: 

o A backup image to be restored. The user can browse disks for an 
appropriate backup image. The Browse for archive page will display 
information on every image selected in the browser window. 
o An item of the selected archive to be restored. The program allows the 
user to restore not only an entire archive, but also separate items of the 
archive. It’s very convenient in case of restoring separate partitions from 
the entire disk archive. 
o A place to restore the archive to. Selecting the destination, please note 
- all contents on the disk selected for restoring purposes will be deleted 
during the operation. The program allows inspecting the resulted disk 
layout. 
o Size of the restored volume (in case of the partition restoring). The 
program allows inspecting the resulted disk layout. 



o Size of the free space before and after the restored partition on the 
disk. 

Results  

Depending on the user’s choice the Restore Wizard: 

o Starts the restore operation, 
o Allows the user to return and correct the parameters mentioned above. 

The wizard will restore a disk (or partition) that has been archived, and make it available 
to use in the operating system.  
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Using the Simple Restore Wizard  
It can happen that the user cannot initiate the restoring process under Windows because 
the operating system is damaged in some way. In this case the Simple Restore Wizard is 
to be used.  

Starting  

In order to start the Simple Restore Wizard the user needs to boot from Recovery Media 
and then launch the wizard. Moreover, if the user should create bootable archives, the 
Simple Restore Wizard will run automatically when the user boots from the first 
CD/DVD of a backup archive. 
 

 



Settings  

The Simple Restore Wizard allows the user to set the parameters of the restore operation: 

o The backup image that contains the system partition to restore. The 
user can browse disks for appropriate backup images. The wizard provides 
in-depth information on the selected archive. 
o A place to restore the archive to. All contents on the disk selected for 
restoring purposes will be deleted during the operation. The program 
enables the user to inspect the resulted disk layout. 
o Size of the restored volume (if necessary). The program allows the user 
to inspect the resulted disk layout. 
o Size of the free spaces before and after the restored partition on a 
disk.  

Results  

After the wizard has completed, the system partition which was stored in the backup 
image, will be restored and the operating system available to use.  
 
 
[ c o n t e n t s]|||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||  

Restoring the System Disk  
The user can restore the operating system with a previously made recovery CD/DVD. It 
is assumed that the recovery CD/DVD was made with the Recovery Media Wizard (see 
the contents of the recovery media settings). The following steps are useful:  

1. Insert the Recovery CD/DVD into a bootable CD/DVD device (the 
BIOS must be enabled to boot the system from the CD/DVD device). 
 
2. Restart the computer. 
 
3. The Simple Restore Wizard will be started automatically. Click the Next 
button on the Welcome page. 
 
4. On the What to restore page, either type the full path to the backup 
image of the system disk, which you are going to restore, or click the 
standard browse button [...] to find it. Click the Next button 
 
5. On the Image properties page, make sure that you select the correct 
image viewing the provided information about the archive. When the 
archive has been chosen, click the Next button.  
 
6. On the disk layout map, select a system disk, to be restored. Click the 



Next button. 
 
7. Set the size of the system partition. The user can compress or expand 
it at the expense of available unused space. Click the Next button. 
 
8. Click the Finish button to initiate the restoring process. 
 
9. After completing the operation eject the Recovery CD/DVD and 
reboot the computer. 

Now the restored file system is operable once again.  
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Restoring Separate Files and Folders from an Image  
To restore separate files and folders from backup images with the Image Explorer follow 
the steps below: 

1. On the Common Task bar, click the Exact Image Explorer button. 
 
2. Select an archive in the Image Explorer's right panel. 
 
3. Select a file (or a folder) in the left panel. 
 
4. Call the context menu. 
 
5. Select the Export item. 
 
6. Select a place on the disk where the file (or the folder) will be extracted 
to. 
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Build Recovery Media  
In addition to the backup tools described above, the program provides the possibility to 
prepare a set of recovery tools on external media (CD, DVD or floppy disks). The tool set 
can be of assistance in case of operating system corruption, which means that the user is 
able to boot the computer even when the operating system is not able to do so. Creation 
of such recovery tools is performed with the Recovery Media Wizard.  

Starting  



To start the Recovery Media Wizard the user needs to select the Recovery Media Builder 
item of the Wizards menu on the Common Tasks bar. Then the Welcome page of the 
wizard is displayed. 
 

 

Settings  

The Recovery Media Wizard allows the user to configure the settings and start the 
operation in accordance with the entered parameters. In our case we set the parameters of 
the future recovery tool by defining: 

o Type of the recovery media the user is creating. The recovery tools 
can be placed either on a CD/DVD disc or on a floppy disk. 
o Contents of the recovery set. The recovery tools can include the 
standard Recovery Media image (included in the installation package) or 
software defined by the user. In the last case the user can record a 
prepared image by setting the path to the image file on the disk. 
o A recording device. The appropriate external media (CD/DVD or a 
floppy disk) needs to be inserted into the selected device. 
o CD/DVD writing parameters (in case the user selects this kind of 
media). Writing parameters include writing speed (maximum or 
minimum) and the ability of ejecting the recorded disc after completing 
the operation. 

The program supports CD-R, CD-RW, DVD-R, DVD+R, DVD-RW and DVD+RW 
discs. If the inserted disc is not empty, the Wizard suggests the user erasing its contents. 
When the user confirms the operation, the program deletes the re-writable disc's contents 
and begins the recording process.  



Results  

The Recovery Media Wizard starts the operation after completing the settings mentioned 
above. As a result, the user receives recovery media, which can be used in most 
emergencies. 
 
When purchasing the program online, Recovery Media is available as ISO-image files. 
The Recovery Media Builder can then write these files onto physical CD/DVDs.  
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Glossary  
Backup Capsule is a specially secured place on the hard disk which is used to store 
backup images. The backup capsule has an independent system layout (e.g. a separate 
partition) and is even operable when the active file system is damaged. To avoid a 
removal or unauthorized access to the data, this partition is hidden and cannot be 
mounted in the operating system. The content of the backup capsule is only available for 
browsing when using special software. 
 
Backup Image is an archive of the disk, which includes all the on-disk files and service 
information on the disk layout. To restore disks from such an archive means retrieving all 
informational components of the disk (e.g. a hard disk image consists of its partitions, the 
Partition Table and even bootstrap code). 
 
Bootable Archives are created by adding a special bootable section when the user is 
backing up the data to CD/DVDs. The user is able to restore the data from these archives 
without having to run the program, but by simply booting from these CD/DVDs. 
 
Hot Backup is a technology developed by Paragon that enables the user to run backup 
operations without having to reboot the Windows system, which may interrupt some 
other process on the computer. 
 
Recovery Media is a CD or DVD (or even a floppy disk) from which the user can boot 
and recover the system. 


